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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
RN4677 PICtail™/PICtail Plus Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the RN4677 PICtail/PICtail Plus Board as a devel-
opment tool to emulate and debug firmware on a target board. The document is orga-
nized as follows:

• Chapter 1. “Overview” – Describes the operating modes of the RN4677 
PICtail/PICtail Plus Board and presents how to establish Bluetooth connection.

• Chapter 2. “Getting Started” – Describes how to establish Bluetooth serial data 
connections using the RN4677 PICtail Board over the USB-UART MCP2200 
interface.

• Appendix A. “RN4677 Module PIN Assignment” - Shows the pinout for 
RN4677 and describes the module’s pins.

• Appendix B. “Schematics”- Shows the RN4677 PICtail/PICtail Plus Board sche-
matics.

• Appendix C. “Questions and Answers”- Lists the most common questions and 
answers for using the RN4677 module.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2015 Microchip Technology Inc. DS50002388A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File > Save

Bold characters A dialog button Click OK

A tab Click the Power tab

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be any 
valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

Notes A Note presents information 
that we want to re-emphasize, 
either to help you avoid a 
common pitfall or to make you 
aware of operating differences 
between some device family 
members. A Note can be in a 
box, or when used in a table 
or figure, it is located at the 
bottom of the table or figure. Note 1: This is a note used in a 

table.

Note: This is a standard 
note box.

CAUTION

This is a caution note.
DS50002388A-page 8  2015 Microchip Technology Inc.
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RECOMMENDED READING

This user's guide describes how to use RN4677 PICtail/PICtail Plus Board. Other 
useful documents are listed below. The following Microchip document(s) are 
recommended as supplemental reference resources:

RN4677 Bluetooth® 4.0 Dual Mode Module Data Sheet (DS50002370A)
This document provides the technical specifications for the RN4677 module and is 
available for download from the Microchip website (www.microchip.com)

RN4677 Bluetooth® 4.0 Dual Mode Module User’s Guide (DS50002377A)
This command reference user’s guide describes how to configure the RN4677 
Bluetooth Dual Mode module.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events; and listings of Microchip sales 
offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools

• Emulators – The latest information on the Microchip MPLAB® REAL ICE™ 
in-circuit emulator

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 3

• MPLAB X IDE – The latest information on Microchip MPLAB X IDE, the 
Windows® Integrated Development Environment for development systems tools

• Programmers – The latest information on Microchip programmers including the 
PICkit™ 3 development programmer
 2015 Microchip Technology Inc. DS50002388A-page 9
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 

http://www.microchip.com/support.

REVISION HISTORY

Revision A (July 2015)

This is the initial release of this document.
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USER’S GUIDE
Chapter 1.  Overview
1.1 INTRODUCTION

This document describes the hardware and software for the RN4677 PICtail™/PICtail 
Plus Board. 

The RN4677 PICtail/PICtail Plus Board enables the designer to evaluate and demon-
strate the capabilities of the RN4677 Dual Mode Bluetooth® RF Module. The evaluation 
board includes an integrated configuration and programming interface for 
plug-and-play capability. It also includes on-board connection and data-status LEDs 
enabling rapid prototyping and fast time to market.

In addition to RN4677 PICtail/PICtail Plus Board hardware, several software 
applications are provided to demonstrate Bluetooth data connections to the on-board 
RN4677 module and optionally configure the RN4677 module. 

The demonstration software application consists of:

• Android™ Chat Application using Serial Port Profile (SPP)

• iOS Bluetooth Terminal (BLETR)

• BT Chat Tool

The configuration software consists of:

• IS1677 Configuration Library

• IS1677 Configuration User Interface (UI) Tool

• IS1677 EEPROM Table Utility

1.2 RN4677 PICtail™ BOARD DESCRIPTION 

The RN4677 PICtail board provides rapid prototyping and developing for Bluetooth 
data applications for Classic SPP or Bluetooth Low Energy using the RN4677 module. 
It can be powered via USB host or through the Microchip PICtail Plus interface. The 
RN4677 PICtail board utilizes the RN4677 module, a fully certified Bluetooth 4.0 dual 
mode RF module supporting Bluetooth Classic SPP and Bluetooth Low Energy 
(BTLE), providing Bluetooth serial data connections. The RN4677 PICtail board 
provides a MCP2200 USB-UART converter for issuing ASCII commands to control or 
configure the RN4677 modules for any specific requirement based on the application. 
The USB-UART converter also provides the flexibility to interface to a host PC, a PC 
terminal utility to drive both classic SPP and BTLE data connections. The RN4677 
PICtail board also provides Microchip PICtail Plus and PICtail interfaces to be able to 
interface with the Microchip PIC® microcontrollers (MCU) using standard Microchip 
development tools, see Figure 1-1.
 2015 Microchip Technology Inc. DS50002388A-page 11
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FIGURE 1-1: RN4677 PICtail™/PICtail PLUS BOARD

1.3 BOARD FEATURES

The RN4677 PICtail board has the following features:

• Fully certified on-board Bluetooth 3.0 + EDR and Bluetooth 4.0 stack

• Class 2 transmitter, +2 dBm typical

• Transparent serial data connection over Bluetooth Classic SPP and Bluetooth 
Low Energy transparent serial data service

• Access to the ASCII command interface over UART available on the RN4677

• On-board Dual In-line Package (DIP) switch block to set operating modes

• PICtail Plus and PICtail interfaces to fully access RN4677 pins using PIC Explorer 
8 and 16 development boards

• Embedded MCP2200 USB-UART converter to enable application mode and 
programming interface to update firmware and configuration settings
DS50002388A-page 12  2015 Microchip Technology Inc.
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1.4 INTERFACE DESCRIPTION

The following are the description of the RN4677 PICtail board in its default 
configuration as represented in Figure 1-2:

1. Bluetooth Module, RN4677 (FP1) 

2. Button to SW_BTN pin (SW1); press the button down to turn ON RN4677  

3. Wake up button to wake up the module from shutdown state (SW2)

4. Reset button for RN4677 Bluetooth module (SW3)

5. Mode Switch (SW4); see Table 1-1, Table 1-2 

6. PICtail interface (J1)

7. PICtail Plus interface (J2)

8. Header that brings out RN4677 pins (CN2)

9. I2C™ expansion port (CN4)

10. Microchip MCP2200 chip; USB/UART serial converter (U3)

11. Mini-B USB connector (P1)

12. Ground (GND) test points (JP1)

13. Status LED (D1)

FIGURE 1-2: RN4677 PICtail™ BOARD INTERFACES
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1.4.1 Mode Definition

Table 1-1 and Table 1-2 show the mode definitions and the mode switch settings of the 
module.

1.5 USB-UART SERIAL INTERFACE

The RN4677 PICtail board consists of an USB-UART converter enabling flexible inter-
face to the host PC, a PC terminal utility and SmartPhone APPs to drive both classic 
SPP and BTLE data connections. The UART port on the RN4677 is exposed through 
an MCP2200 USB-UART serial converter for interfacing easily with a host PC. 

Connecting the mini-B USB receptacle (P1) on the RN4677 PICtail board to the USB 
port on a PC enumerates the RN4677 PICtail board as a Composite Device Class 
(CDC) USB device for serial communication. After the MCP2200 enumerates, a dedi-
cated COM port is assigned on the host PC for serial communication with the RN4677 
on the RN4677 PICtail board. A PC terminal utility or application opens then the 
assigned COM port and connects to the UART port on RN4677 for serial data transfer 
or to configure and control RN4677. If the MCP2200 does not enumerate, ensure that 
the MCP2200 drivers are downloaded and manually installed from 
www.microchip.com/MCP2200. 

TABLE 1-1: MODE DEFINITIONS

Mode
Switch 
Number

1 2 3

Pin Name P20 P24 EAN

ON Low Low High

Function EEPROM/Test mode 
High = Disable/Application 
Low = Enable/Test mode

Flash Write 
High = Disable 
Low = Enable

Boot to Flash or ROM 
Application 
High = ROM 
Low = Flash

TABLE 1-2: MODE SWITCH SETTINGS

Mode Switch PIN Definition

Write Flash 1 = P20: Low
2 = P24: Low
3 = EAN: High

EEPROM/Test 1 = P20: Low
2 = P24: High
3 = EAN: Low

Application
(default)

1 = P20: High
2 = P24: High
3 = EAN: Low
DS50002388A-page 14  2015 Microchip Technology Inc.
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1.6 PICtail PLUS AND PICtail INTERFACE

The PICtail Plus and PICtail interface on the RN4677 PICtail board is used to configure 
and transfer data to the RN4677 module over the UART using an external PIC MCU 
and to send and receive raw data over UART. The PICtail interface can also be used 
to access the UART and the GPIOs on the RN4677 module.

Section 2.5 “Using RN4677 PICtail™ Board in PICtail Interface Mode” provides 
more information on the PICtail Plus and PICtail interfaces.
 2015 Microchip Technology Inc. DS50002388A-page 15
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Chapter 2.  Getting Started
2.1 INTRODUCTION

This chapter describes how to establish Bluetooth® serial data connections using the 
RN4677 PICtail Board over the USB-UART MCP2200 interface (P1). The purpose of 
the exercise is to demonstrate the basic data capabilities of the RN4677, and 
interoperability with other Bluetooth devices. Note that in all these demonstrations, the 
RN4677 is a Bluetooth slave waiting for a connection initiated by the Bluetooth master 
device.

This chapter discusses the following topics:

• Hardware Requirements

• Software Requirements

• Using RN4677 PICtail™ Board in USB-UART Serial Interface Mode

• Using RN4677 PICtail™ Board in PICtail Interface Mode

2.2 HARDWARE REQUIREMENTS 

The following hardware applications are required to demonstrate the RN4677 PICtail:

• RN4677 PICtail Board, (Part# RN4677-PICTail), available for purchase on 
www.microchipdirect.com

• Bluetooth-enabled Smartphone or Tablet

- Android™ device running Android 4.3 or later

- iOS: iPhone® 4S or later, iPad®3 or later, must support Bluetooth Low Energy

• Windows® Host PC with USB port 

• Bluetooth adapter supporting 2.0+EDR or later

2.3 SOFTWARE REQUIREMENTS 

The following software applications are required to demonstrate the RN4677 PICtail:

• RN4677-PICTAIL webpage: www.microchip.com/rn-4677-pictail

• Bluetooth (BT) Chat Tool, BT Chat v004.exe available for download at
 www.microchip.com/rn-4677-pictail

• Android BtChat APP, BtChat_V1.0.3.apk available at
 www.microchip.com/rn-4677-pictail

• iOS Terminal "BLETR", available on Apple® AppStore (iOS)

• MCP2200 driver for Windows, available at www.microchip.com/MCP2200

• PC terminal emulator such TeraTerm or CoolTerm
 2015 Microchip Technology Inc. DS50002388A-page 17

www.microchipdirect.com
www.microchip.com/rn-4677-pictail
www.microchip.com/MCP2200
www.microchip.com/rn-4677-pictail
www.microchip.com/rn-4677-pictail


RN4677 PICtail™/PICtail Plus Board User’s Guide
2.4 USING RN4677 PICtail™ BOARD IN USB-UART SERIAL INTERFACE MODE 

This section discusses the following topics:

• how to exercise the RN4677 module using the USB-UART serial interface on the 
RN4677 PICtail Board,

• scanning for the devices and connecting to the selected device with the ASCII 
command over the UART interface of the RN4677 using the USB-UART serial 
converter on the board,

• establishing the Bluetooth Classic and Bluetooth Low Energy data connections

• transferring data on the RN4677 module through the USB-UART serial interface, 
which is demonstrated via PC utility and Smartphone applications. 

2.4.1 Bluetooth Classic® (SPP) Connection to Host PC

In this demonstration, a Bluetooth (SPP) data connection is established between the 
RN4677 PICtail Board connected to PC via USB and local Bluetooth HOST. A terminal 
emulator, such as TeraTerm, is used to communicate with the RN4677 PICtail, and on 
the Host PC Bluetooth adapter to initiate connection to RN4677 PICtail, as illustrated 
in Figure 2-1.

FIGURE 2-1: COM PORT CONNECTIONS 

Use the Host PC Bluetooth adapter to add the RN4677 PICtail device to it's list of 
managed Bluetooth devices. In this demo, an SPP connection is made to RN4677 
PICtail using the HOST PC's internal Bluetooth adapter.

To connect the RN4677 PICtail to Host PC and initiate communication with the RN4677 
module, use the following steps :

1. Ensure that the RN4677 PICtail Board is unplugged from the PICtail interface of 
a Microchip Explorer 16 development board.

2. Verify that SW4 switches are set to application mode (1: OFF, 2: OFF, 3: OFF).

3. Ensure that SW1 button is set in the ON position (pushed down).

4. Use a mini-B USB cable and connect the RN4677 PICtail Board mini-B USB 
receptacle (P1) to a host PC USB port to power up the RN4677 PICtail Board. 
See Figure 2-2. The blue connection LED1 (D1) indicates the connection state 
as follows:

- Stand–by State: the LED1 on RN4677 PICtail Board blinks once at a time. 

- Pairing, Connected State: the LED1 blinks twice at a time. 
DS50002388A-page 18  2015 Microchip Technology Inc.
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FIGURE 2-2: CONNECT THE RN4677 PICtail™ BOARD TO A HOST PC 
USB PORT 

5. Ensure that the virtual COM port, COM18 in this example, is enumerated as 
shown in Figure 2-3.

FIGURE 2-3: VIRTUAL COM PORT ENUMERATED

6. Open the virtual COM port created in Step 5, COM18 in this example, using a ter-
minal emulator such as TeraTerm shown in Figure 2-4, with the serial port set-
tings illustrated in Table 2-1.

Note: A virtual COM port must be created when the RN4677 PICtail Board is 
connected to a PC. If a virtual COM port is undetected in the Device 
Manager port list, install the Microchip MCP2200 driver.
(www.microchip.com/MCP2200)
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FIGURE 2-4: TERMINAL EMULATOR - TERATERM

7. Type $$$ in terminal emulator to enter command mode. As shown in Figure 2-5, 
a CMD> prompt is returned when in command. In Command mode, any data 
received on the RN4677 UART is interpreted as a command to access features 
or functions of the module. 

FIGURE 2-5: ENTER COMMAND MODE

TABLE 2-1: SERIAL PORT SETTINGS FOR VIRTUAL COM PORT

Definition Value

Port Virtual COM Port

Baud Rate 115200

Data Bits 8 bits

Parity None

Stop Bits 1

Flow Control None
DS50002388A-page 20  2015 Microchip Technology Inc.
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8. [Recommended] Enable local echo by pressing + followed by the <Enter> key 
when interacting with RN4677 Command mode using a terminal emulator. The 
ECHO ON status message displays and any commands sent to UART echoes 
back to sender.

9. Type D and press <Enter>/Return key into the terminal emulator application 
window to get the summary of the  current settings of the module as illustrated in 
Figure 2-6.

FIGURE 2-6: RN4677 CURRENT SETTINGS

10. Type I and press <Enter>/Return key into the terminal emulator application to 
initiate an active scan for all the Bluetooth Classic devices in Discovery mode 
nearby.  Figure 2-7 displays the scan results.

FIGURE 2-7: SCAN FOR BLUETOOTH® CLASSIC DEVICES

In the following steps the RN4677 PICtail device is added to the HOST PC's Bluetooth 
Device Manager. This step enables the HOST to initiate an SPP connection from 
HOST PC to RN4677 PICtail just by opening a virtual COM port using a terminal emu-
lator. In this example, the PICtail name "RN4677-20AE" is used. The Bluetooth device 
name may be different for the provided RN4677 PICtail.

11. In the Control Panel, click on <Add a device> from Hardware and Sound cate-
gory. If the HOST PC has a working Bluetooth Adapter, a device scan is initiated. 
Figure 2-8 shows that the "RN4677-20AE" PICtail is discovered.
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FIGURE 2-8: ADD A NEW DEVICE

12. Select the "RN4677-20AE" device and click Next button.

13. The HOST PC's Bluetooth device manager attempts to pair with the PICtail 
Device “RN4677-20AE”. Figure 2-9 shows the list of pairing options. If the HOST 
PC supports Bluetooth 2.1+EDR or later, select "Pair without using a code". Oth-
erwise, select "Enter the device's pairing code", and then enter "1234" when 
prompted for a code.

FIGURE 2-9: SELECT PAIRING METHOD
DS50002388A-page 22  2015 Microchip Technology Inc.
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14. When the "RN4677-20AE" device is successfully added to the Host's Bluetooth 
Device Manager, a confirmation message displays. See Figure 2-10.

FIGURE 2-10: NEW DEVICE CONFIRMATION

15. Note that adding "RN4677-20AE" to the Host PC results in creating another vir-
tual COM port, which is illustrated in the device manager as COM24, see 
Figure 2-11. Any application, such as TeraTerm, that opens COM24 initiates a 
Bluetooth SPP connection from HOST PC to “RN4677-20AE” device.

FIGURE 2-11: OUTGOING PORT
 2015 Microchip Technology Inc. DS50002388A-page 23
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16. Use TeraTerm to initiate a Bluetooth SPP data connection from host PC. See 
Figure 2-1 for the illustration of test setup.

17. Open a TeraTerm connection as described in Step 7.

18. From the File Menu, select New Connection > Bluetooth COM port (COM24 in 
this example). Click OK to start RN4677connection.

19. Verify that %CONNECT,xxxxxxxxxxxx,0% are received on TeraTerm session 
connected to RN4677. The "xxxxxxxxxxxx" is the Media Access Control (MAC) 
address of the Bluetooth adapter on HOST PC.

20. Type any text characters in the terminal session connected to RN4677 PICtail 
(COM18). The characters are sent to the RN4677 on COM18, and then over 
Bluetooth SPP connection to the Bluetooth adapter in the HOST PC. Figure 2-1 
shows the data path.

21. Verify that the text characters entered into the RN4677 (COM18) display in the 
other TeraTerm session connected to Bluetooth COM port (COM24 in this exam-
ple).

22. From the TeraTerm session connected to the Bluetooth COM port (COM24 in this 
example), enter any text. Verify that the text is received in other TeraTerm ses-
sion (COM18 in this example).

23. Use <ALT-I> key sequence to close COM port.

24. Wait until %DISCONNECT% message is received from the remote TeraTerm ses-
sion to indicate that the Bluetooth SPP data connection is terminated. See 
Figure 2-12.

FIGURE 2-12: TERMINAL (A) TO TERMINAL (B) OVER BT SPP
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2.4.2 Bluetooth® SPP Connection to Android Smartphone/Tablet

In this demonstration, a Bluetooth SPP data connection is established between the BT 
Chat Tool and the Smartphone application via RN4677 PICtail Board. For the SPP 
demonstration, an Android 4.3 or later Smartphone or tablet is required.

As illustrated in Figure 2-13, the host PC runs a BT Chat Tool application, transferring 
serial data over a COM port (USB virtual COM port) to the RN4677 PICtail Board. The 
serial data is then transmitted over a Bluetooth connection to the remote Bluetooth 
device, which is the Android BtChat APP.

FIGURE 2-13: BLUETOOTH® SPP CONNECTION TO SMARTPHONE

To establish a connection, perform the following steps:

1. Ensure that the RN4677 PICtail Board is unplugged from the PICtail interface of 
a Microchip Explorer 16 development board.

2. Verify that SW4 switches are set to application mode (1: OFF, 2: OFF, 3: OFF).

3. Ensure that SW1 button is set in the ON position (pushed down).

4. Use a mini-B USB cable and connect the RN4677 PICtail Board mini-B USB 
receptacle (P1) to a host PC USB port to power up the RN4677 PICtail Board. 
See Figure 2-2. The blue connection LED1 (D1) indicates the connection state 
as follows:

- Stand–by State: the LED1 on RN4677 PICtail Board blinks once at a time. 

- Pairing, Connected State: the LED1 blinks twice at a time. 

5. Ensure that the virtual COM port (COM18 in this example) is enumerated as 
shown in Figure 2-3.
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6. Run the BT Chat v004.exe file from your PC and ensure that the COM Port 
is connected. See Figure 2-14.

a. Select the COM Port assigned to the RN4677 PICtail Board

b. Ensure that the default Baud Rate is 115200

c. Click Connect button. 

FIGURE 2-14: CONNECT TO COM PORT

7. The Connect button changes into a Disconnect button once Step 6 is com-
pleted. Use the “Input” field to enter characters to transmit. Click Send to transmit 
text to Smartphone over the RN4677 PICtail Board Bluetooth connection as 
shown in Figure 2-15.

a. Check the Burst send box to enable sending the text repeatedly from this 
tool.

b. Input a value into the “Repeat” field to set the number of times of resending 
the text. 

c. Select the desired value from the Interval drop-down list to set the time inter-
val between two successive sent attempts.

d. Press the Clear button to delete the text on the screen, if required.
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FIGURE 2-15: BT CHAT TOOL SETTING

8. Install the Android Bluetooth Chat application into the Android device by copying 
or downloading the BTChat_V1.0.3.apk file. The .apk file can be copied into 
the Android device by using an SD Card to transfer the file, or by plugging 
Android device into the host PC, where the Android device mounts as an external 
USB drive. Note that Android Media Transfer Protocol (MTP) is required on host. 
Once the file is copied into the Android device, follow the instructions below:

a. Go to the downloaded file. Click the file to install from the Android File Man-
ager "My Files" App. If necessary, enable the "Unknown Sources" from the 
Device Security settings of the phone to allow the installation. See 
Figure 2-16.

Note: Black texts are sent from PC tool (RN4677 PICtail Board) to Smartphone. 
Red texts are sent from Smartphone to the PC tool (RN4677 PICtail Board).

a

b c

d
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FIGURE 2-16: INSTALL THE ANDROID BLUETOOTH® CHAT APPLICATION

b. The BtChat APP displays in the Application view after successful installation,  
see Figure 2-17.

FIGURE 2-17: BTCHAT APP ON ANDROID

9. To pair the RN4677 PICtail Board with the Android Device, open Settings > Blue-
tooth page on the Android device and then set to ON to turn ON Bluetooth, see 
left image in Figure 2-18. Press Scan to initiate the Bluetooth Device scan, find 
the RN4677 PICtail Board device named Dual-SPP, and then select to start the 
pairing process.

BtChat Application
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Once paired, the Dual-SPP (RN4677 PICtail Board) device is listed in the paired 
device list, see right image of Figure 2-18. 

FIGURE 2-18: PAIR RN4677 PICtail™ BOARD WITH THE ANDROID DEVICE

10. Launch the BtChat APP on the Android Device to display the BTChat APP main 
window. See Figure 2-19. To open BtChat menu options, use the menu button of 
the phone. Select the Setting button to open the APP setting view. To show the 
received text in the APP, select the Show Rx Text option. Press the Back button 
of the phone to return to the main window.

FIGURE 2-19: SET BTCHAT APP

Turn ON
Bluetooth

Press Scan

Start pairing

Dual-SPP

BTChat APP main window   Select Setting Enable “Show Rx Text”
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11. To set up a Bluetooth SPP connection to the RN4677 PICtail device, go to the 
BtChat APP main window. See Figure 2-20. Press the menu button of the phone 
to open the BtChat menu options and then select the Connect a device button 
to open the paired device list. Select the Dual-SPP device to open an SPP con-
nection to the RN4677 PICtail Board. A status message displays in the main win-
dow when a connection is established.

FIGURE 2-20: SET UP THE BLUETOOTH® SPP CONNECTION

12. To transfer data from the RN4677 to the Android Device via Bluetooth SPP con-
nection, launch the BT Chat Tool on the host PC and set the correct COM port 
corresponding to the RN4677 PICtail Board as described in Figure 2-14.

a. Enter text into the Android BtChat APP to send it to the BT Chat Tool on the 
PC. Click Send to transmit the text entered to RN4677 that is connected to 
the BT Chat Tool. Text received on the BT Chat Tool window displays in red.

b. Enter text into the BT Chat Tool to send it to the RN4677 PICtail Board. Click 
Send to transmit text into the Android BtChat APP. Text is received in 
Android BtChat APP. See Figure 2-21.

Select Connect a device Select Dual-SPP Connection established
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FIGURE 2-21: DATA TRANSFER FROM RN4677 TO ANDROID DEVICE

2.4.3 Bluetooth® Low Energy Data Connection to iOS Device

This demonstration shows how serial data is transmitted from RN4677 PICtail Board 
(via PC Chat) to an iOS device using Bluetooth Low Energy (BLE) connection. This 
demonstration uses the ISSC BLETR APP to establish connection with the RN4677 
PICtail Board. BLETR can be downloaded from APP Store and ensure to disable the 
“iPad only” filter as this is an iPhone APP. A key feature of the RN4677 module is the 
transparent serial data connection from RN4677 UART to an iOS device over Bluetooth 
Low Energy connection.

1. Download and install "ISSC BLETR" APP from Apple AppStore (iOS) using an 
iPhone 4S or later, iPad3 or later devices. See Figure 2-22.

FIGURE 2-22: ISSC BLETR APP
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2. Go to Settings > General > Bluetooth Page. Turn ON the Bluetooth. See 
Figure 2-23.

FIGURE 2-23: TURN ON BLUETOOTH

3. Launch the ISSC BLETR APP to scan for the Bluetooth Low Energy (BTLE) 
peripheral devices. If the device is not displaying on the list, press the Refresh 
or Scan button to restart the BTLE peripheral scan. Find the Dual-SPP device 
and then select to start a connection to the RN4677 PICtail Board. See 
Figure 2-24.

FIGURE 2-24: SCAN FOR BTLE DEVICES

Select Dual-SPP
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4. BLETR displays the Dual-SPP device status as connected after a successful 
connection. See Figure 2-25.

FIGURE 2-25: DUAL-SPP CONNECTED

5. Select the connected Dual-SPP device to display the top level view, see 
Figure 2-26. This view displays the following three options when connected to a 
RN4677 PICtail Board as shown in Figure 2-27:

Transparent: Select this view to display received data, send data, and enable 
features.

Proprietary: Select this view to set the Bluetooth Low Energy connection 
parameters.

Device Info: Select this view to display the settings for Bluetooth Low Energy 
Device Information Service.
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FIGURE 2-26: ISSC BLETR APP TOP LEVEL VIEW

FIGURE 2-27: ISSC BLETR APP OPTIONS
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2.4.3.1 TRANSPARENT DATA VIEW

The Transparent data view enables to display received data, send data, and enable 
features. Selecting the Transparent button opens the transparent serial data view as 
shown in Figure 2-28. The default mode is Raw mode (ASCII), where the received data 
characters are displayed in red font in the large text box.

FIGURE 2-28: DATA MODE TRANSFER
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Select the input text box to send data from BLETR iOS device to the RN4677. The soft 
keyboard displays as shown in Figure 2-29. Enter text in the input text box and click 
Send to transmit text to the RN4677 over BLE connection.

FIGURE 2-29: SOFT KEYBOARD

The text is received via the RN4677 UART after clicking Send and displayed in the BT 
Chat Tool window on the PC as shown in Figure 2-30.

FIGURE 2-30: TEXT RECEIVED VIA THE RN4677 UART
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Timer Feature

In addition to the Raw mode (ASCII), the Transparent data view includes a Timer  and 
Echo features, see Figure 2-28. The Timer feature enables the BLETR to send a 
repeated test pattern to BT Chat Tool for throughput and data transfer test. Figure 2-31 
shows an example of the Timer test feature.

BLETR is configured to transmit a 100 test blocks of 20 characters in every 1000 ms. 
BT Chat Tool on PC receives the test pattern data and displays it in red text. The line 
break indicates a Bluetooth Low Energy packet break, which means that a transmitted 
test block is fragmented into multiple BLE packets. Clicking the Start button initiates 
the data transfer.

FIGURE 2-31: TIMER TEST FEATURE

Echo Feature

The Echo feature is an optional function for the Transparent data view. If Echo is 
enabled, any data received by BLETR is echoed back to the sender. Figure 2-32 shows 
text sent from BT Chat Tool (PC) being echoed to BLETR when the Echo mode is 
enabled.
 2015 Microchip Technology Inc. DS50002388A-page 37



RN4677 PICtail™/PICtail Plus Board User’s Guide
FIGURE 2-32: ECHO FEATURE

TX File Feature

Another test feature similar to the Timer feature is the TX File transfer. The TX File func-
tion transfers files, which is embedded in the BLETR APP, to the RN4677. The steps to 
use this feature is represented in Figure 2-33:

a. Click the TX File button to open a dialog box with the list of file sizes to transmit. 

b. Select the file size to send.

c. Observe the file received on BT Chat Tool.

FIGURE 2-33: TX FILE FEATURE

a

c

b
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2.4.3.2 PROPRIETARY DATA VIEW

The Proprietary data view demonstrates the capability to remotely change Bluetooth 
Low Energy connection parameters via BLETR application. These parameters only 
affect Bluetooth Low Energy connections.

• Max Interval: communication time interval (ms) between RN4677 and BLE Cen-
tral device.

• Connection Timeout: determines the timeout (ms) between data exchanges 
before a connection is considered lost.

• Latency: number of peripheral (RN4677) connection events allowed to be 
skipped without risking disconnection.

• BLE name used to advertise Peripheral name to scan Central devices. To change 
device name, type new name in the text box and click Change Name to apply the 
change. See Figure 2-34.

FIGURE 2-34: CHANGE DEVICE NAME
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2.4.3.3 DEVICE INFORMATION VIEW

The Device Information view displays the characteristics associated with Device 
Information service. The Device Information service is available to all Bluetooth 4.0 
Low Energy hosts that access the RN4677 PICtail Board. It provides the identification 
information about the RN4677 BLE peripheral device.

FIGURE 2-35: DEVICE INFORMATION
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2.5 USING RN4677 PICtail™ BOARD IN PICtail INTERFACE MODE

The PICtail interface is used to access the UART and the GPIOs available on the 
RN4677 module. The PICtail interface configures the RN4677 over the UART using an 
external PIC® MCU and then sends and receives raw data over the UART. The PICtail 
interface is also used to access GPIOs on the RN4677 using a PIC MCU.

Using the PICtail Plus (J2) or PICtail (J1) interface, the board can be plugged into any 
standard Microchip development board, such as the Explorer 16 Development Board 
(DM240001) or the PIC18 Explorer Board (DM183032), that supports the PICtail Plus 
or PICtail connection interface.

The PICtail interface is used to configure the RN4677 by updating Bluetooth parame-
ters on the internal EEPROM, updating the RN4677 firmware on the internal flash, and 
entering the RN4677 into application mode. In application mode, pairing procedure is 
performed on the RN4677 after establishing a Bluetooth connection for SPP or BLE 
data transfer.

Figure 2-36 and Figure 2-37 show the pin mapping for the PICtail Plus 30-pin interface 
and the PICtail 28-pin interface.

FIGURE 2-36: PIN MAPPING FOR THE PICtail 30-PIN INTERFACE

FIGURE 2-37: PIN MAPPING FOR THE PICtail 28-PIN INTERFACE
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The RN4677 PICtail Board can be inserted into the PICtail Plus/PICtail interface header 
available on Microchip development tools as shown in Figure 2-38 and Figure 2-39.

FIGURE 2-38: RN4677 PICtail™ BOARD INSERTED INTO PICtai PLUS 
INTERFACE

FIGURE 2-39: RN4677 PICtail™ BOARD INSERTED INTO PICtail 
INTERFACE

Note: Ensure that the RN4677 module on the board is facing the PIC PIM while 
inserting the RN4677 PICtail Board into either of the PICtail headers.
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Appendix A. RN4677 Module PIN Assignment
A.1 RN4677 MODULE PIN ASSIGNMENT

Figure A-1 shows the pinout for RN4677 module.

FIGURE A-1: RN4677 MODULE PIN ASSIGNMENT

Table A-1 describes the module’s pins.
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TABLE A-1: PIN DESCRIPTION

RN4677 
Pin

RN4677U 
Pin

Symbol Type Description

1 — GND Power Ground reference

2 — GND Power Ground reference

3 1 GND Power Ground reference

4 2 BAT_IN Power Battery Input. Main positive supply input. Connect to 10 µF low ESR 
ceramic capacitor.

5 3 SW_BTN DI Software Button H: Power On / L: Power Off
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6 4 LDO33_O Power Internal 3.3V LDO regulator output. Connect to 10 µF low ESR 
ceramic capacitor.

7 5 VDD_IO Power I/O positive supply input. Ensure VDD_IO and MCU I/O voltages are 
compatible.

8 6 LDO18_O Power Internal 1.8V LDO regulator output. Connect to 10 µF low ESR 
ceramic capacitor.

9 7 WAKEUP DI Wakeup from Shutdown mode (active-low; internal pull up)

10 8 PMULDO_
O

Power Power management unit output. Connect to 1 µF low ESR ceramic 
capacitor.

11 9 P04 DO Status Indicator 2 (STATUS_IND_2)

12 10 P15 DO Status Indicator 1 (STATUS_IND_1)

13 11 P12/SCL DO I2C SCL (Do not connect)

14 12 P13/SDA DIO I2C SDA (Do not connect)

15 13 P17/CTS DIO Configurable control or indication pin or UART CTS (input)

16 14 P05 DIO Configurable control or indication pin

17 15 P00/RTS DIO Configurable control or indication pin or UART RTS (output)

18 16 P20 DI System configuration (internal pull up)

19 17 P24 DI System configuration (internal pull up)

20 18 EAN DI System configuration (internal pull down)

21 19 RST_N DI Module Reset (active-low; internal pull up). Apply a pulse of at least 
63 ns.

22 20 RXD DI UART data input

23 21 TXD DO UART data output

24 22 P31 DIO Configurable control or indication pin (when configured as input: 
internal pull up)

25 23 P32 DIO Configurable control or indication pin (when configured as input: 
internal pull up)

26 24 P33 DIO Configurable control or indication pin (when configured as input: 
internal pull up)

27 25 P34 DIO Configurable control or indication pin (when configured as input: 
internal pull up)

28 26 P36 DIO Do not connect

29 27 P37 DIO Configurable control or indication pin (when configured as input: 
internal pull up)

30 28 LED1 DO Status LED

31 29 GND Power Ground reference

— 30 BT_RF AIO External antenna connection (50 Ohm)

32 — GND Power Ground reference

33 — GND Power Ground reference

Note: Pin type abbreviation: A = Analog, D = Digital, I = Input, O = Output.

TABLE A-1: PIN DESCRIPTION (CONTINUED)

RN4677 
Pin

RN4677U 
Pin

Symbol Type Description
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Appendix B. Schematics
B.1 RN4677 PICtail™/PICtail Plus Board Schematics

Figure B-1 shows the RN4677 PICtail/PICtail Plus Board schematics.
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Appendix C. Questions and Answers
C.1 QUESTIONS AND ANSWERS

1. Is the RN4677 Module Data Sheet available?

Yes. The RN4677 data sheet is available for download on 
www.microchip.com/RN4677. 

2. When I connect the RN4677 PICtail board to the host PC, the COM port does 
not appear. What should I do?

Try to unplug the USB cable and plug it back to the PC. Check if the MCP2200 
drivers are installed. Otherwise, download and install the MCP2200 drivers.

3. What is the maximum supported Baud Rate of RN4677 UART?

The maximum baud rate is 921600 used with 16 MHz crystal.

4. How do you change Bluetooth® parameters such as name, Device Info, 
COD, rate, inquiry and page scan windows?

The configuration settings are accessed using the ASCII Command interface. 
Enter Command mode using $$$ as described in Section 2.4.1 “Bluetooth Clas-
sic® (SPP) Connection to Host PC” and issue commands to change the desired 
settings. For more information on the Command mode, the available commands 
and their description, refer to the “RN4677 Bluetooth® 4.0 Dual Mode Module 
User’s Guide” (DS50002377A).

5. What is the default security mode for SPP?

Simple Secure Pairing (SSP)/”Just Works” mode.

6. Is there an Android™ BTLE demonstration application?

At this time, Android support for dual-mode Bluetooth devices, such as the 
RN4677, is limited to Bluetooth Classic SPP data service.

7. Is the source code for iOS and Android APP available?

Contact your Microchip representative to request the source code packages for 
the smartphone Apps.
 2015 Microchip Technology Inc. DS50002388A-page 47
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